Introduction to Document Scanning
Table of Contents

DM Scan Batch Viewer.................................................................................................................................. 2

Image Batch Selection.................................................................................................................................. 2

  Adding a New Image Batch ................................................................................................................... 3

  Viewing a Batch ..................................................................................................................................... 3

  Clearing a Batch .................................................................................................................................... 3

  Unlocking a Batch.................................................................................................................................. 4

Batch Scan Viewer..................................................................................................................................... 4

  Adding Documents to a Batch .............................................................................................................. 7

  Attaching Documents to Data Records ................................................................................................. 8

  Printing Documents ............................................................................................................................ 10
DM Scan Batch Viewer

The DM Scan Batch Viewer is available if you have purchased the scanning module. It enables a process for adding large amounts of scanned documents to batches, removing documents from batches, and clearing batches. All documents scanned into a batch are stored in the Viewpoint V6 database. In addition, the DM Scan Batch forms enable you to attach documents to data records in the software.

Image Batch Selection

Use this form to view existing batches, add documents to a batch, and/or clear a batch. (See Figure A.) You can access the Image Batch Selection form using any of the following three methods.

- Select **Open Image Batch** from the Scanning button on most forms.
- Select **Scan>Open Image Batch** from the Tools menu on most forms.
- Select **DM Scan Batch Viewer** from the Document Management Programs folder.

![Image Batch Selection form with existing batches](image.png)

**Figure A.** Image Batch Selection form with existing batches
Upon accessing this form, the **Available Image Batches** grid displays,

- each existing batch and a description
- the number of documents in the batch
- who created the batch
- when the batch was created
- how many documents within the batch are unattached to data records
- who is currently using the batch
- and whether the batch is restricted.

**Adding a New Image Batch**

To create a new batch:

1. Enter a name in the **Batch Name** field. Make sure the description adequately describes the content of the batch.
2. Check the ‘**Restricted**’ box if you want to limit access to the batch. When this box is checked, other users cannot view the batch.
   **Note**: Once the batch is restricted, it cannot be changed to unrestricted. If you wish to allow other users access, clear the batch and create a new, unrestricted one.
3. Click the **Add Batch** button. The batch is added to the **Available Image Batches** grid and the **Batch Scan Viewer** form displays.

**Viewing a Batch**

To view a specific batch:

- highlight the batch and click the **OK** button
  or
- double-click a batch record.

This will bring up the **Batch Scan Viewer** form.

**Clearing a Batch**

Use this option when you want to delete a batch and all of its associated images.

1. Highlight the batch you wish to delete.
2. Go to the **File** menu and select **Clear Batch**.
3. Click **Yes** when the warning displays.

**Note**: Once a batch is deleted, any associated images must be rescanned if they are to be added to another batch.
Unlocking a Batch
The In Use By column indicates whether a batch is currently in use and by whom. If a batch is “in use,” it does not necessarily mean that a user is currently in the batch entering data. In some cases, the system flags a batch as “in use” because of an interrupted validation or program error.

To unlock a batch:
1. Right-click on the batch in the grid.
2. Select Unlock Batch.

Note: You can only unlock batches created by your own user ID. Batches that are “in use” by another user must be unlocked by that user.

Batch Scan Viewer
Use this form to:

- view images in a batch,
- add scanned documents to a batch,
- attach documents to specified data records.

The form’s layout defaults in two panes. (See Figure B.)

- The Thumbnail pane displays all batch images in thumbnail format.
- The Image pane shows a larger preview of the selected document.

The header area of the form displays:

- the batch description,
- the total number of documents in the batch,
- the number of unattached documents,
- and the default attachment type for the batch.
There are a number of display and attachment options on this form. The following table describes each option.

<table>
<thead>
<tr>
<th>Display/Attachment Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="View button" /></td>
<td>Use the View button to rearrange the layout of the viewer by clicking the arrow and selecting the desired option. Options include:</td>
</tr>
<tr>
<td></td>
<td>- Thumbnail and Image - displays both the Thumbnail and the Image panes. This is the default option.</td>
</tr>
<tr>
<td></td>
<td>- Thumbnail only - the viewer only displays the Thumbnail pane.</td>
</tr>
<tr>
<td></td>
<td>- Image only - the viewer only displays the Image pane.</td>
</tr>
<tr>
<td><img src="image" alt="Auto Attach" /></td>
<td>When you set this option to checked (the green checkmark displays) the system will automatically add selected documents to the next record that</td>
</tr>
<tr>
<td>Display/Attachment Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>you create on a form. For more information, see Automatically Attaching Documents to Data Records below.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Hide Attached</strong></td>
<td>When you set this option to checked, the system will not display documents in the batch that have been previously attached.</td>
</tr>
<tr>
<td><strong>Attach</strong></td>
<td>Click this button to manually add a document to a data record. For more information, see Manually Attaching Images to Data Records below.</td>
</tr>
<tr>
<td><strong>Description Picker</strong></td>
<td>The <strong>Description Picker</strong> option allows you to designate how the description for each image is generated. Select the Description Picker icon and drag it to the desired field on your entry form. For example, if you are entering AP invoices and you want the image description to be the AP Reference number, drag the icon to the field (making sure that a black box surrounds the field). Each time you enter and save a transaction header, the Auto Attach feature pulls the transaction’s AP Reference number and uses it as the image description.</td>
</tr>
<tr>
<td><strong>Previous and Next</strong></td>
<td>The <strong>Previous and Next</strong> arrows allow you to move to the next or previous page in a multi-page documents. The number displays the current page number that you are viewing.</td>
</tr>
<tr>
<td><strong>Zoom In</strong></td>
<td>This button allows you to zoom in.</td>
</tr>
<tr>
<td><strong>Zoom Out</strong></td>
<td>This button allows you to zoom out.</td>
</tr>
<tr>
<td><strong>Selection Cursor</strong></td>
<td>Click this button to activate the selection cursor. Use the selection cursor to draw a box around the area of the image that you wish to zoom in to.</td>
</tr>
<tr>
<td><strong>Fit Width</strong></td>
<td>Click this button to fit the image to the width of the Image pane.</td>
</tr>
<tr>
<td><strong>Fit Height</strong></td>
<td>Click this button to fit the image to the height of the Image pane.</td>
</tr>
<tr>
<td>Display/Attachment Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image.png" alt="Left Rotate" /></td>
<td>Click this button to rotate the image to the left in the Image pane.</td>
</tr>
<tr>
<td><img src="image.png" alt="Right Rotate" /></td>
<td>Click this button to rotate the image to the right in the Image pane.</td>
</tr>
</tbody>
</table>

**Adding Documents to a Batch**

There are two ways to add documents to the batch.

- Documents can be added from a file directory on your network,
- or can be added via a scanner attached to your computer.

**Directory**

This option allows you to add all existing scanned documents from a specified network folder. Typically, this option is used when large amounts of documents have been scanned on to your network and you need to bring the batch into Viewpoint. The following file types are supported: .pdf, .jpg, .jpeg, .tif, and .tiff.

*Note:* When displaying PDF files, the Batch Scan Viewer uses a snapshot of the PDF, which may cause the resolution to be less than ideal. To adjust the resolution, use the PDF View Resolution field in DM Attachment Options.

To add images from a directory:

1. Click the Get Images button ( ) and select From Directory. A Browse for Folder window displays.
2. Select the directory that contains the documents you want and click OK.
3. Click Yes to delete the files or click No to leave the documents in their original location. All documents from the specified directory will now display in the Batch Scan Viewer.

*Note:* Documents that display here are copied from the source directory to a table in your database. If you click Yes in step 3, the system deletes the documents from the original location.
Scanner

This option allows you to scan documents into the batch. Use this option to scan documents from a scanner attached directly to your computer.

To add documents from a local scanner:

1. If you are planning to scan a large amount of multi-paged documents, specify a number in the **Pages per Document** field, as necessary. For example, if you are scanning a batch of two page invoices, enter “2.” This sets the scanning process to group pages in twos and a separate document is created for each group.
2. Click the **Get Images** button ( ) and select **From Scanner**. The **Select Source** window displays.
3. Select the correct scanner.  
   **Tip:** If the Select Source window is empty, then the TWAIN driver is not properly installed. This is not a problem with the Viewpoint V6 Software, but a problem with the installation of scanner drivers. With USB devices, it is always best to install the driver prior to plugging in the device.
4. Configure your scanner as appropriate and scan the documents. All created images display in the **Batch Scan Viewer**.
5. Enter an attachment type in the **Attachment Type** field, if necessary. Press **F4** for a list of available attachment types.

   **Note:** If you add an attachment type to the batch, this attachment type defaults for each document in the batch when you attach documents to records using this form.

**Attaching Documents to Data Records**

Once you have added documents to a batch, you can attach them to specific data records. Documents are added to the data record currently active on the selected form. When attached, documents are moved from the database to the location specified in DM Attachments Options.

**Note:** Once scanned documents are attached to data records, they are treated like any other document. They can be accessed via the Attachments button ( ) on the toolbar of any form. They can be sent through the document routing process and are managed via DM Manage Attachments.

There are two ways that you can attach scanned documents to data records. You can add documents manually or you can have the system automatically attach documents as you create new records in the system.

**Manually Attaching Documents to Data Records**

1. Open the form associated with your data record and find the record that you wish to attach the document to.
   For instance, to attach an insurance certificate to an AP Vendor, open the AP Vendor Master form and pull up the vendor.
2. Click the arrow to the right of the Scanning button and select Open Image Batch. The Image Batch Selection form displays.
3. Select the batch to open from the grid and click OK. The Batch Scan Viewer displays.
4. Select the thumbnail of the document that you want to add. The image then displays in the right-hand pane.
   **TIP:** To select multiple documents to add, shift-click consecutive documents or control-click to select non-consecutive documents.
5. Enter the attachment type for the document in the Attachment Type field or accept the default. Press F4 for a list of attachment types.
   **NOTE:** This field defaults with the attachment type that you specified in this field when you originally added the scanned documents to the batch. If you change the attachment type here, each subsequent document will default with this attachment type, which you can change as necessary.
6. Click Attach. The system attaches the scanned document to the selected data record.
   **NOTE:** If you checked the Hide Attached option, the document no longer displays in the Batch Scan Viewer.
7. Repeat step 4-6 to add additional documents to the selected data record.

**Automatically Attaching Documents to Data Records**

1. Open the form where you want to attach images.
   For instance, if you want to attach scanned invoices to AP Transaction Entries, open the form and create a Transaction Entry batch.
2. Click the arrow to the right of the Scanning button and select Open Image Batch. The Image Batch Selection form displays.
3. Select the batch to open from the grid and click OK. The Batch Scan Viewer displays.
4. Check the ‘Auto Attach’ option.
5. If you want the document’s description to default to some type of information on the form, drag and drop the Description Picker icon ( ) to the desired field on the form. For instance, you can select the Invoice number on a vendor’s invoice.
6. Select the thumbnail of the image that you want to add first.
7. Enter the attachment type for the document in the Attachment Type field or accept the default. Press F4 for a list of attachment types.
   **NOTE:** This field defaults with the attachment type that you specified in this field when you originally added the scanned documents to the batch. If you change the attachment type here, each subsequent document will default with this attachment type, which you can change as necessary.
8. Create and save a new record on the form you are attaching documents to. The document you selected in step 6 will automatically be attached. The focus will then return to the first document in the list.
   **NOTE:** If you checked the Hide Attached option, the document no longer displays in the Batch Scan Viewer.
As you continue to add records, the system attaches each subsequent document in the batch to the newly created record.

The attachment status of a document can be set manually by right-clicking on the thumbnail. Documents can be marked as attached or unattached. When marked as attached, the document does not display when selecting the Hide Attached option. Typically, this is done to hide a document that will not be used and does not necessarily mean that the document has been attached to a record. To mark a document as unattached, right click the image and select Mark Unattached.

**Printing Documents**
You can print documents from the scan batch by selecting **File>Print Images**. The system will print all documents in the thumbnail pane. If you do not want to print previously attached documents, click the **Hide Attached** button to remove the documents from the thumbnail pane. The system prints images in the thumbnail pane display order.